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Предисловие 
Перед разработчиками радиоэлектронных устройств и аппаратов часто возникает 
необходимость создания высококачественных чертежей или рисунков принципиальных 
электрических схем, которые можно было бы напечатать типографским способом в книге 
или журнале. Для этих целей имеются специальные программы – редакторы схем, но эти 
программы зачастую не могут удовлетворить требовательного разработчика. 
Рисунки схем можно создавать при помощи описанных в моей книге «Моделируем 
работу радиосхем» программ EWB 5.12 и Multisim 2001. Но эти программы выполняют 
схемы в американском стандарте и не поддерживают русский алфавит. Использовать 
созданные в этих программах схемы в лучшем случае можно только для распечатки на 
принтере, что не всегда является достаточным. 
Программа CircuitMaker 6.0 фирмы MicroCode Engineering (www.microcode.com), на мой 
взгляд, наилучшим образом подходит для обозначенных выше целей. Одно из самых 
значительных достоинств этой программы для российского человека заключается в том, 
что программа отлично работает с русским алфавитом. Кроме того, с помощью этой 
программы можно создавать очень компактные принципиальные схемы, а затем сохранять 
эти схемы или в формате с расширением *.bmp (как рисунки) или в формате с 
расширением *.wmf – как метафайлы Windows.  
Кроме того, программа хорошо выполняет проверку работоспособности созданных схем. 
На рис. 1 в качестве примера показано главное рабочее окно программы при проверке 
работоспособности схемы мультивибратора на двух транзисторах. 

 
Рис. 1. Рабочее окно программы Circuit Maker 6.0 
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Программа содержит обширную библиотеку моделей промышленных изделий 
электронных компонентов с возможностью оперативного просмотра их основных 
характеристик (например, транзистора – это тип корпуса, максимальное напряжение, ток, 
частота, фирма-изготовитель и др.).  
Повторим еще раз особенности этой программы: 

 программа позволяет достаточно оперативно подготавливать электрические схемы 
аналоговых, цифровых или смешанных аналогово-цифровых устройств. 

 проводить моделирование этих схем с получением результатов в виде осциллограмм 
сигналов и графиков частотных характеристик, возможно получение точных отсчетов с 
помощью вертикальных и горизонтальных визирных линий; 

 позволяет контролировать режим по постоянному и переменному токам в выбранных 
точках схемы; 

 интересной особенностью программы является наличие анимационных компонентов 
(запуск ракеты, старт автомобилей), призванных имитировать конечный результат 
работы схемы; 

 интегрируется с программой разработки печатных плат TraxMaker. 
Программа имеют коммерческую и студенческую версии. Студенческая версия 
практически не отличается от профессиональной, скачать её можно с указанного выше 
сайта. 
Чтобы убедить вас в хорошей работоспособности студенческой версии программы, на 
рис. 2 привожу главное рабочее окно этой программы, в котором выполняется 
моделирование работы модема типа modem22, описание этого модема можно найти в [1]. 

 

Рис. 9.2. Рабочее окно студенческой версии программы 
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Сравните рис. 1 с рис. 2 и вы убедитесь, что все пункты меню (кроме пункта Macros в 
версии 6.0) и командные кнопки в рабочих окнах одной и другой программы совпадают. 
Как показал опыт, моделирование работы схем различных радиоустройств с помощью 
программы EWB 5.12 осваивается быстрее, чем с программой CircuitMaker 6.0. 
Последняя из этих программ не будет выполнять процесс моделирования до тех пор, пока 
в схеме будут находиться хотя бы малейшие ошибки или неточности, в то время как 
EWB 5.12 на такого рода неточности просто не обращает внимания. Похоже, что 
разработчики программы EWB 5.12 считают, что мелкие ошибки или неточности почти 
всегда можно обнаружить по показаниям задействованных в процессе моделирования 
измерительных приборов. 
В то же время схемы радиоустройств, выполненные с помощью программы CircuitMaker 
6.0, очень хорошо смотрятся и могут быть выполнены в соответствии с отечественными 
стандартами. При этом схемы могут быть экспортированы либо в формате рисунка (с 
расширением *.bmp) либо в формате метафайла Windows (с расширением *.wmf), что 
очень удобно для создания качественных рисунков (чертежей) схем, пригодных для 
печати этих схем типографским способом.     

 
 

 

Рис. 3. Главное рабочее окно CircuitMaker Student 
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Структура окна и система меню  CircuitMaker  
На рис. 3 показано главное рабочее окно программы CircuitMaker Student. В самом 
верху, как обычно для Windows приложений, располагается информационная строка с 
названием программы и поле главного меню. Ниже располагается поле командных 
кнопок, каждая из которых снабжена всплывающей подсказкой, появляющейся в верхней 
информационной строке при установке курсора на поверхность кнопки. Для лучшего 
восприятия описаний, каждая из командных кнопок мною пронумерована. 
Ниже этих двух полей располагается специальное окно, предназначенное для создания 
радиоэлектронных принципиальных схем, которые собираются из отдельных 
компонентов (радиодеталей), соединенных между собой линиями электрической связи. 
При этом для каждой новой схемы создается свое специальное окно.  
Главное меню программы состоит из следующих пунктов: File, Edit, Macros, Options, 
View, Simulation, Window, Devices и Help. Рассмотрим подробнее каждый из пунктов 
меню, при этом наибольшее внимание мною будет уделено только тем пунктам, которые 
задействованы в процессе создания радиоэлектронных схем. 

Пункт меню File 
Большинство подпунктов этого пункта меню являются типовыми для Windows 
приложений и, по моему мнению, останавливаться на них не следует. Отметим только 
подпункты, задействованные в создании схем. 
Reopen – этот подпункт вызывает вспомогательное окно, посредством которого можно 
загрузить в программу любую из нескольких последних разработок. Смотрите рис. 4. 

 

Рис. 4. Действие подпункта Reopen 
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Merge – позволяет к имеющейся в рабочем окне схеме добавить еще вторую схему. При 
этом первую схему необходимо перенести вправо, освободив левую часть окна для второй 
схемы. В версии Student этот подпункт не работает.  
Revent – позволяет имеющуюся в рабочем окне схему сохранить вместо другой, 
расположенной в доступной для программы папке.  
Import – позволяет загрузить в рабочее окно программы схему из внешнего файла. 
Export – сохраняет имеющуюся в рабочем окне схему в виде картинки с расширением 
*.wmf, *.dib или *.bmp. Для этой процедуры сначала необходимо командой  
Export=>Options вывести на экран вспомогательное окно Export Options, изображенное 
на рис. 5. 

 

Рис. 5. Вспомогательное окно Export Options 

В этом окне следует установить тип картинки, в который нужно экспортировать данную 
схему. В показанном на рисунке варианте схема будет экспортирована в рисунок с 
расширением *.bmp.  
Чтобы сравнить по внешнему виду все три вида рисунков с экспортированными схемами, 
мною в рис. 6, 7 и 8 приведены соответственно все три варианта - *.bmp,  *.dib и *.wmf.  
Как видно из этих рисунков, только последнему из них присущи четкие изображения 
различных дуг, наклонных линий и окружностей. 

 

Рис. 6. Рисунок в формате *.bmp 

5 



       Г. А. Тяпичев   «Создаем принципиальную радиосхему» 
--------------------------------------------------------------------------------------------------------------------     

 

Рис. 7. Рисунок в формате *.dib 

 

 

Рис. 8. Рисунок в формате *.wmf 

Preferences… – выполняется настройка всех основных параметров программы. При 
выборе этого подпункта меню на экране появляется диалоговое окно Preferences, 
показанное на рис. 9. 
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Рис. 9. Окно Preferences 

 
В этом окне в первую очередь необходимо установить в качестве основного шрифт Arial 
CYR – этот шрифт устанавливается в строке редактирования, расположенной справа, 
вверху. Какие – то другие изменения на первых порах освоения делать не советую. 
Особенно не стоит нажимать на расположенную слева внизу клавишу Factory Settings. В 
случае нажатия на эту клавишу страшного ничего, разумеется, не произойдет, но на схеме 
появится большое число лишних жирных точек в местах электрического контакта линий 
связи с компонентами.  
  
 
  

Пункт меню Edit 
Назначение всех подпунктов этого пункта понятно из названий подпунктов, поэтому здесь 
следует выбрать подпункт Font, для того, чтобы задействовать в программе русские 
буквы. После выбора Font на экране появляется диалоговое окно Font (или Шрифт), 
изображенное на рис. 10. 
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Рис. 10. Диалоговое окно выбора шрифта 

Шрифт Arial 8, обычный, рекомендуется издательствами для использования на различных 
рисунках.  
 

Пункт меню Macros 
Этот пункт имеется только в программе CircuitMaker 6.0 и служит для самостоятельного 
созданий необходимых компонентов, отсутствующих в библиотеке программы. Так, 
например, мне самому пришлось создавать макросы компонентов, изображенных на 
рис. 11. 

 

Рис. 11. Дополнительные компоненты 

Для создания нового компонента выбирается Macros=>New. Появляется диалоговое окно, 
в котором следует ввести название нового компонента и нажать <OK>. После этого 
появляется окно, изображенное на рис. 12, в котором происходит процесс создания нового 
компонента. 
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Рис. 12. Окно Symbol Editor для создания нового компонента 

Процесс создания нового компонента не должен вызывать каких либо затруднений.  
В окне Symbol Editor справа располагается окно, в котором предстоит рисовать 
схематическое изображение нового компонента.  
Сначала, если это необходимо, следует нанести сетку. Делается это выбором пункта Grid 
(справа, внизу). При желании изображение можно делать в увеличенном масштабе, 
который выбирается кнопками <вверх> и <вниз> в блоке View. Величина масштаба (в 
процентах) появляется здесь же. 
Для рисования линий необходимо слева, в списке операций, выбрать операцию Line, что 
позволяет рисовать прямые линии в окне создания компонента. Выполнение этой 
операции показано на рис. 12. В списке имеются операции для рисования нескольких 
типов линий, операции для рисования окружности, эллипса, дуги. 
Очень внимательно необходимо отнестись к установке выводов (Pin) компонента. 
Помните, что PinDown обозначает вывод компонента (микросхемы, транзистора и т.д.), 
расположенного в нижней части компонента и предназначенный для подсоединения к 
компоненту электрической линии снизу.  Компонент PinDown~ обозначает то же самое, 
но выход от компонента (или вход на компонент) выполняется с инверсией.  
Pinleft – вывод располагается с левой стороны компонента, Pinright – вывод для правой 
стороны компонента, PinUp – вывод для верхней стороны компонента. 
Прошу обратить внимание на расположенное внизу слева окно, в котором записываются 
координаты любой операции, выполненной над компонентом. Достаточно в этом списке 
выбрать курсором какую либо стоку, как соответствующая этой строке линия (или вывод, 
или окружность) тут же окажутся выделенными красным цветом. 
И еще. При создании компонента поддерживаются только буквы латинского алфавита. 
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Пункт меню Options 
Пункт предназначен для установки различных опций, но в первый период освоения выбор 
подпунктов должен соответствовать рис. 13. Подпункт Auto Refresh обозначает 
обновление создаваемой схемы в процессе работы, а подпункт Quick Connect – быстрое 
создание надежного электрического контакта в процессе работы над созданием схемы. 
Например, чтобы подключить землю к выводу компонента достаточно подвести вывод 
компонента земли с выводом основного компонента. Контакт будет установлен без 
соединения этих выводов линией. 

 

Рис. 13. Пункт меню Options 

Подпункты Grid (сетка), Title Block (рамка для наименования чертежа) и Border (рамка 
обрамления чертежа) следует выбирать только при необходимости. 

 

Пункт меню View 
Подпункт Toolbar выводит на экран линейку командных кнопок. Этот подпункт должен 
быть всегда выделен.  
Подпункт Colors выполняет выбор цвета, пользоваться им следует только при 
необходимости. 
Остальные подпункты в период освоения желательно не выбирать. 

 

Пункт меню Simulation 
Этот пункт служит для выбора основных параметров процесса моделирования работы 
созданной схемы. Основным является подпункт Analyses Setup.  
Описание параметров процесса моделирования работы схем не входит в задачу этой 
главы, поэтому останавливаться на особенностях этого пункта нет необходимости. При 
желании подготовленному читателю не составит большого труда разобраться со всеми  

10 



       Г. А. Тяпичев   «Создаем принципиальную радиосхему» 
--------------------------------------------------------------------------------------------------------------------     
подпунктами этого пункта меню. На рис. 14 показано рабочее окно программы с 
выбранным пунктом меню Simulation. 
 
 

 

Рис. 14. Выбран пункт меню Simulation 

Подпункт Run включает процесс моделирования, подпункт Display Waveform выдает на 
экран график выполнения процесса моделирования. 

 

Пункт меню Window 
Этот пункт меню является типовым для Windows приложений, поэтому дополнительных 
пояснений не требует. 

 

Пункт меню Devices 
Служит для выбора и вывода на экран различных компонентов, содержащихся в 
библиотеке программы. 
Подпункт Browse…x выводит на экран информационное окно Device Selection, 
предназначенное для выбора компонента, и показанное на рис. 15.  
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Рис. 15. Информационное окно для выбора компонента 

 
Информационное окно Device Selection слева вверху содержит три расположенных рядом 
небольших окна. В крайнем слева находится перечень различных разделов 
задействованной в программе библиотеки компонентов. Так, например, активные 
компоненты – транзисторы, диоды и т.п. содержатся в разделе Active Components, 
кварцевые резонаторы содержатся в разделе Crystals и т.д..  
В среднем небольшом информационном окне следует выбирать название компонента, а в 
третьем окне – выбирается вариант исполнения выбранного компонента. Схематическое 
изображение выбранного компонента появляется в окне, расположенном вверху справа 
(см. рис. 15). Ниже этого окна располагаются кнопки и окна редактирования, 
предназначенные для выбора основных параметров компонента, для поворота и 
зеркального отображения схематического изображения компонента.   
После завершения всех операций по выбору компонента следует нажать клавишу <Place>, 
в результате чего картинка со схематическим изображением компонента окажется на 
поверхности рабочего окна программы. Теперь необходимо отбуксировать эту картинку в 
предназначенное для неё место и нажать левую клавишу мышки. На рис. 15 показан 
процесс выбора транзистора.   
 
Подпункт Search…X выводит на экран окно поиска нужного компонента Device Search, 
показанное на рис. 16. 
 
Этот подпункт необходимо выбирать тогда, когда имеется необходимость установить 
какие то особые конструктивные особенности выбранного компонента. На рис. 16 
выполнен поиск для компонента Resistor. 
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Рис. 16. Окно поиска компонента 

Пункт меню Help 
Пункт меню Help не имеет каких то особенностей и, на мой взгляд, не требует пояснений. 

 Командные кнопки CircuitMaker  
Обратимся снова к рис. 3, на котором цифрами помечены все основные командные кнопки 
рабочего окна программы CircuitMaker Student.  
№ 1 – основная из командных кнопок программы, которая включается по умолчанию 
после запуска программы в работу. Служит для удаления и редактирования компонентов 
(и данных по компонентам), работы с линиями электрической связи и при работе с 
текстами.  
Всякий раз, после завершения какой либо команды, необходимо нажимать эту командную 
кнопку с изображенной на ней стрелкой. Только в это командном режиме можно выделять 
какие-то компоненты, перемещать схематические изображения самих компонентов и 
относящихся к компоненту записей. 
№ 2 – командная кнопка для создания электрических связей между выводами 
компонентов. 
№ 3 – командная кнопка для создания текстовых записей. 
№ 4 – кнопка служит для удаления компонента или линии электрической связи. 
№ 5 – кнопка под этим номером служит для поступенчатого увеличения схемы. Чтобы 
вернуться после увеличения к нормальному масштабу изображения следует в главном 
меню выбрать View=>Normal Size/Position.  
№ 6 – служит для поворота на 90º выделенного красным цветом компонента. 
№ 7 – служит для зеркального отображения вокруг вертикальной оси выделенного 
компонента. 
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№ 8 – кнопка индикаторная, показывает к какому виду – аналоговому или цифровому 
относится создаваемая в рабочем окне схема. Если на кнопке изображен транзистор, 
значит схема аналоговая, если изображен логический элемент И, то схема цифровая. 
№ 9 – используется при аналоговом или цифровом моделировании. 
№ 10 – используется для поступенчатого цифрового моделирования. 
№ 11 – командная кнопка, запускающая в работу созданную схему, т.е. запускающая 
процесс моделирования. 
№ 12 – кнопка превращает курсор в наконечник измерительного прибора, который в 
цифровой схеме показывает состояние в схемы точке, которой касается наконечник, а для 
аналоговой схемы показывает напряжение или ток в данной точке. 
№ 13 – кнопка используется как индикатор при моделировании цифровых схем. 
№ 14 – командная кнопка, посредством которой можно вывести на экран результат 
моделирования схемы в виде графика. 
№ 15 – кнопка служит для вывода на экран окна Device Selection для выбора компонента 
и вывода выбранного компонента на экран. Аналогично команде главного меню   
Devices=>Browse…x. 
№ 16 – кнопка служит для вывода на экран окна Device Search для поиска свойств 
компонента. Аналогично команде главного меню Devices=> Search…X. 
№ 17 – кнопка используется при создании нового компонента или изменении в 
выделенном компоненте. 
№ 18 – командная кнопка используется для экспорта PCB netlist и для работы с 
программой TraxMaker.  
  

 

Как создать схему 
Создание принципиальных электрических схем радиоэлектронных устройств с помощью 
программы CircuitMaker большого труда не представляет. В порядке обмена опытом 
предлагаю вам применяемый мною порядок поэтапной разработки схем. 
1. На бумаге делаю эскиз схемы. 
2. Запускаю программу CircuitMaker 6.0 и, посредством воздействия на командную 

кнопку № 15 (рис. 3), вывожу в рабочее окно программы все компоненты, необходимые 
для данной схемы. Следует учитывать тот факт, что программа автоматически 
проставляет номера (по порядку, начиная с № 1) всех компонентов данного типа. 
Поэтому компоненты нужно выводить на рабочее окно в точном соответствии с 
созданной в пункте 1 схемой, начиная с левой стороны. При этом нужно стараться 
сразу устанавливать компонент на предназначенное для него место. 

3. После того, как все компоненты расставлены по своим местам, следует проверить 
соответствие принадлежащих каждому из компонентов данных с данными по схеме из 
пункта 1. Если возникает необходимость изменить данные резистора, конденсатора или 
катушки индуктивности, то следует выполнить двойной щелчок левой клавишей 
мышки на картинке этого компонента. При этом появляется диалоговое окно, в 
котором следует внести нужные изменения. Пример для изменения данных резистора 
показан на рис. 17. 
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Рис. 17. Окно с параметрами резистора 

4. Если имеется необходимость изменить параметры транзистора, то при двойном 
щелчке на изображении этого компонента на экране сначала появится диалоговое окно, 
показанное на рис. 18. Здесь необходимо нажать клавишу <Netlist>, после чего 
появляется окно, показанное на рис. 19, в котором можно будет выполнить все 
необходимые изменения. 

 

Рис. 18. Промежуточное окно для транзистора 
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Рис. 19. Окно с параметрами транзистора 

5. После того, как будут уточнены параметры каждого из компонентов, необходимо 
связать между собой все компоненты электрическими соединительными линиями. Для 
этого нажимается командная кнопка № 2 (см. рис. 3). Курсор превращается в крестик. 
Центр курсора устанавливается на вывод компонента, при этом на курсоре появляется 
небольшой прямоугольничек красного цвета, что говорит о совпадении центра курсора 
с нужным выводом компонента. Теперь следует нажать левую клавишу мышки и веси 
курсор к тому выводу компонента, с которым должен быть электрически связан 
предыдущий вывод. При совпадении центра курсора с нужным выводом снова 
образуется прямоугольничек красного цвета, теперь можно отпустить нажатую левую 
клавишу мышки. Между двумя задействованными в этой операции выводами должна 
появиться линия синего цвета. Нужные выводы соединены.  

6. Точно таким же способом, описанном в предыдущем пункте, необходимо выполнить 
все соединения в соответствии с предварительно созданной в пункте 1 схемой.  

7. Схема готова. Сначала схему необходимо сохранить в заранее приготовленной папке. 
Теперь можно попробовать нажатием на командную кнопку № 11 (см. рис. 3) запустить 
схему в работу. Если в схеме нет ошибок или значительных неточностей, в рабочем 
окне программы появится (в верхнем левом углу) изображение рабочей панели 
мультиметра, а в нижней части окна появится график, являющийся результатом работы 
вашей схемы (для примера см. рис. 2). Используя командную кнопку № 12 (см. рис. 3) 
можно проводить измерения в различных точках схемы. По показаниям мультиметра и 
характеру графической зависимости можно добиться оптимальной работы созданной 
вами схемы. 

8. Следующим этапом необходимо создать схему, соответствующую отечественным 
стандартам (ЕСКД) для принципиальных электрических схем. Дело в том, что все 
задействованные в программе компоненты могут быть показаны на схеме или по 
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стандартам США, или по немецким стандартам (DIN). Чтобы выполнить изменения в 
схеме в соответствии с отечественными стандартами, необходимо сделать доработку 
схемы с помощью других программ. Для этих целей созданную схему следует 
экспортировать в рисунки с расширением *.bmp и *.wmf. 

9. Чтобы экспортировать созданную вами схему в формат *.bmp необходимо в главном 
меню выбрать команду File=>Export=>Options…. В появившемся диалоговом окне 
Export Options, изображенном на рис. 20 следует выбрать строку Device dependent 
bitmap и нажать клавишу <OK>.  Этими действиями вы выбираете условие для 
экспортирования схемы в формате *.bmp. Теперь нужно выполнить 
File=>Export=>Circuit as Graphic.  Появляется окно Save Bitmap File, которое 
позволяет сохранить файл экспортируемой схемы в заданную папку. 

 

Рис. 20. Окно выбора формата файла 

10.   Чтобы экспортировать созданную вами схему в формат *.wmf необходимо в главном 
меню выбрать команду File=>Export=>Options…. В появившемся диалоговом окне 
Export Options, изображенном на рис. 20 следует выбрать строку верхнюю строку 
Windows Merafile и нажать клавишу <OK>.  Этими действиями вы выбираете условие 
для экспортирования схемы в формате *.wmf. Теперь нужно выполнить 
File=>Export=>Circuit as Graphic.  Появляется окно Save Metafile, которое позволяет 
сохранить файл экспортируемой схемы в заданную папку. 

11. Теперь вы вплотную подошли к последнему этапу, который позволит создать рисунок 
принципиальной электрической схемы, соответствующей отечественным стандартам 
(ЕСКД) для электрических схем. Но для этих целей необходимо воспользоваться 
программами Paint и Corel Draw.         

 
 
 
 
 

Доработка схемы программой Paint 
Программу простого графического редактора Paint можно вызвать командой Пуск=>Все 
программы=>Стандартные=>Paint.  
 
Командой File=>Open необходимо открыть в рабочем окне программы Paint созданную 
вами схему, которая была предварительно экспортирована в формат рисунка *.bmp. 
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Рабочее окно программы Paint с помещенной в него схемой простого LC генератора 
показано на рис. 21. 
 

 

Рис. 21. Рабочее окно программы Paint 

 
 
Чтобы доработать эту схему, потребуется не так уж много усилий. 

 Необходимо изменить изображение символа заземления. Если бы в схеме был 
применен электролитический конденсатор, то его изображение тоже нужно было бы 
заменить. Также потребовалась бы замена символов различных диодов.  

 Необходимо изменить написание номинальных величин конденсаторов, резисторов и 
катушек индуктивности. 

 Необходимо изменить обозначение транзисторов, диодов и микросхем. 
 
Доработанный вариант рисунка схемы показан на рис. 22. 
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Рис. 22. Доработанный вариант схемы 

Полученный рисунок схемы необходимо сохранить в соответствующей папке. Для 
указанной выше доработки рисунка схемы можно использовать любой другой, более 
удобный для вас графический редактор.  
 

Доработка схемы программой  

Corel Draw 10 
Эта программа довольно хорошо распространена и, мне думается, не составит большого 
труда приобрести её у своих друзей или в Интернете. Пригодится любая версия этой 
программы. 
После запуска программы Corel Draw 10 в работу на экране появится главное рабочее 
окно программы, изображенное на рис. 23, но только в центре рабочего окна не будет 
прямоугольника, изображающего лист бумаги.  

 
Рис. 23. Главное рабочее окно Corel Draw 10 
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Прямоугольник в центре окна появится после ввода команды Файл=>Новый. Затем 
следует выбрать Файл=>Импорт, в результате чего появится диалоговое окно для выбора 
импортируемого в программу файла с рисунком разработанной вами схемы, показанное 
на рис. 24. 

 

Рис. 24. Диалоговое окно Импорт 

В диалоговом окне вы выбираете нужный рисунок со схемой, выполненный в формате 
*.wmf, и нажимаете клавишу <Импорт> или делаете двойной щелчок левой клавишей 
мышки на тексте выбранного файла. На экране сразу же появится главное окно 
программы, при этом курсор примет вид прямого угла, составленного из двух коротких 
отрезков линии. Установите курсор в верхний левый угол прямоугольного листа и 
потяните мышкой курсор вправо и вниз, определив этим правый нижний угол 
импортируемого рисунка. После щелчка левой клавишей мышки в положении нижнего 
правого угла, на листе появится изображение схемы, показанное на рис. 25.  
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Рис. 25. Импортирование рисунка в программу 

Но это изображение будет показано в масштабе 100% и покажется вам слишком мелким. 
Для увеличения масштаба можно в окне редактирования масштаба, расположенном 
вверху, прямо над прямоугольником листа, выбрать любую величину кнопками <вверх> 
<вниз> или ввести цифровое значение масштаба с клавиатуры. 
 
Чтобы очистить схему от лишних элементов, необходимо в главном меню программы 
выбрать Компановать=>Разгруппировать Все.  Это позволит каждый из элементов 
рисунка, каждую букву, выделять отдельно от других элементов. Выделенный элемент 
легко удаляется нажатием клавиши <Delete> на клавиатуре компьютера.  
 
Послн того, как будут выполнены все удаления, следует в главном меню выбрать 
Компановать=>Группа. После этой команды все элементы схемы будут объединены в 
группы, в соответствии со схематическими изображениями компонентов.  
 
Для того, чтобы отредактировать текст, например, наименования транзистора, 
необходимо выделить этот текста мышкой и в главном меню выбрать 
Текст=>Редактировать Текст. Тотчас на экране появится окно Редактирование текста, 
показанное на рис. 26, в котором можно выполнить все необходимые операции по 
редактированию.  
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Рис. 26. Окно для редактирования текста 

Программа позволяет выполнить копирование любого элемента схемы, что очень удобно 
для создания нового текста. Для этого выделяем какой-то текст и в главном меню 
выбираем  Редактировать=>Копировать, а затем выбираем – 
Редактировать=>Вставить. При этом на месте выделенного элемента окажется еще и его 
точная копия, которую можно взять и перенести в любое другое место и отредактировать 
или ввести совсем новый текст.  
 
После того, как все вспомогательные операции будут выполнены и схема примет свой 
окончательный вид, следует сохранить файл с рисунком в соответствующей папке. 
Делается это по команде Файл=>Сохранить как…. Диалоговое окно, посредством 
которого выполняется сохранение файла, показано на рис. 27. 
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Рис. 27. Диалоговое окно 

На рис. 28 показан рисунок радиосхемы, созданный с применением программы Corel 
Draw 10. 
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Рис. 28. Схема, доработанная в Corel Draw 10 

Применение рисунков, созданных или доработанных с помощью программы Corel Draw 
10, удобно тем, что можно очень легко изменять размеры этих рисунков, масштабировать 
их при подготовке к печати.  
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